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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.  The TReK CFDP 

application provides the capability to transfer files using the Consultative Committee for 

Space Data Systems (CCSDS) File Delivery Protocol (CFDP). 

 

This tutorial provides step-by-step instructions describing how to perform common 

application functions.   

 

This tutorial uses screen dumps taken on a Windows computer.  However, the steps are 

the same regardless of whether you are running on Windows or Linux.   

 

1.1 System Requirements 

Windows 7, Red Hat Enterprise Linux 6.x. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK software 

applications, please try the following suggestions: 

 

Read the corresponding material in the manual and/or on-line help. 

 

Ensure that you are correctly following all instructions. 

 

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked 

Questions. 

 

If you are still unable to resolve your difficulty, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:  trek.help@nasa.gov 

Telephone:  256-544-3521 (7:00 a.m. - 3:30 p.m. Central Time) 

Fax:   256-544-9353 

 

TReK Help Desk hours are 7:00 a.m. – 3:30 p.m. Central Time Monday through Friday.  

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time. 
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3 Introduction 

The TReK CFDP application provides the capability to transfer files using the 

Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol 

(CFDP).   

 

The CCSDS File Delivery Protocol (CFDP) was developed by the Consultative 

Committee for Space Data Systems (CCSDS).  Official specifications are contained in a 

CCSDS document called the CFDP Blue Book (available at www.ccsds.org).  CFDP 

provides reliable transfer of files from one computer to another, and has been designed to 

work well over space links.  It can be used to perform space to ground, ground to space, 

space to space, and ground to ground file transfers.  The underlying communications 

protocol used by the TReK CFDP application is the User Datagram Protocol (UDP). 

 

CFDP requires a sender and a receiver.  The sender and receiver must be configured and 

running at the same time to perform a file transfer.  Each party is referred to as an 

“Entity”.  The sender is an entity and the receiver is an entity.  Each “Entity” must have a 

unique Entity ID.   For example: 

 

 
 

 

To move a file from one computer to another, you will enter one or more CFDP 

Commands (primitives) to indicate the action to be taken.  The syntax of a primitive is as 

follows: 

 

[CFDP Directive] [Class of Service] [source-path] [remote-EID] [destination-path] 

 

Example:  put class2 D:\file1.txt 2 /home/kirk/file1.txt 

 

The TReK CFDP application currently supports two CFDP Directives:  put and get.  

These are defined as follows: 

 

Put:  To copy one file from the local entity to the remote entity. 

Get:  To copy one file from the remote entity to the local entity. 

 

The file you want to transfer is considered the “Source” and the location it should be 

transferred to is considered the “Destination”. 

 

Don’t worry there is no need to type in CFDP Commands unless you want to.  You can 

use drag and drop to build your CFDP Command list. 

 

Note:  The Get directive is not supported in all ISS CFDP implementations.  It is 

supported by TReK when both the sender and receiver are TReK CFDP implementations 

(TReK CFDP application, TReK CFDP console application, or TReK CFDP Library). 

http://www.ccsds.org/
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4 Overview of the User Interface 

4.1 Main Window 

The main window contains several areas as shown in Figure 1.  Each area is a dock 

window that you can float or dock.  To float a dock window, use your left mouse button 

to click and hold the title area while dragging the window to another area of the screen.  

To dock, use the title bar to drag the dock window over the main window and drop. 

 

 

Figure 1 Main Window 

Toolbar 

The toolbar at the top of the window provides quick access to configure the application 

and start and stop the CFDP service.  

 

CFDP Commands 

The CFDP Commands area provides a way to add and execute one or more CFDP 

commands (primitives).  Add a “put” command to send a file to a remote entity.  Add a 

“get” command to retrieve a file from a remote entity.  The “Show Directory” button 

provides access to the local file system.  Files can be dragged from this view of the local 

file system or from a file explorer window.   Files can also be added by pushing the Add 

Row button and typing in the file transfer information.  To delete a file from the list put 

your cursor in the row you would like to delete and push the Remove Row button.  To 

delete all files in the list push the Clear All button.  The Export List button provides a 

way to save the list of CFDP Commands in a file.  The Import List button provides a way 

to load a list of CFDP Commands from a file.  Each CFDP command entered into the list 

must include a Directive (put or get), the Class of Service (class1 or class2), the absolute 
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path of the source file, the Remote Entity ID (Remote EID), and the absolute path of the 

destination file.  The Class of Service default is class2.  To execute all the CFDP 

commands (puts and gets) in the list, push the Execute All button.  After you push the 

Execute All button, the Restore All button can be used to restore the list of commands.  

The Restore All button will only restore the list of CFDP commands previously sent by 

pushing the Execute All button.  The Default Destination menu can be used to identify a 

default destination.  This can save typing when dragging and dropping files into the list.  

If the Default Destination is set, the destination selected will automatically be copied into 

the Destination field when a file is dropped into the list.  The Default Destination menu 

can be populated using the Configure dialog.   

 

Note:  You can enter the absolute path for a directory in the Source and Destination 

fields.  All the files in the first level of the directory will be transferred.  Subdirectories 

will not be transferred.  Each file in the directory will result in the execution of an 

individual CFDP Command (primitive).  Therefore, the transactions area will contain 

transaction information for each file transferred. 

 

Note 2:  There are two types of files supported by the CFDP application: the CFDP 

Application Configuration File and the CFDP Commands List file.  File/Save/Save As 

can be used to save an Application Configuration File.  The File/Open command provides 

a way to open an Application Configuration File.  The Export List button provides a way 

to save a CFDP Commands List file.  The Import List button provides a way to load a 

CFDP Commands List file.     

 

Transactions 

The Transactions area displays file transfer activity as it is in progress.  The Configure 

button displays the Configure dialog which provides a way to show and hide columns and 

rearrange the order of the columns.  To Clear, Pause, Resume, or Cancel one or more 

transactions, select the transactions in the list and push the desired button.   

 

Message Area 

The Message Area displays important status and error messages.  The message area can 

be cleared using the View menu. 

 

 

4.2 Toolbar 

The toolbar provides visual information about the state of the application and provides 

access to common application functions.   

 

Configuration Status 

When the Configuration status is black, this indicates the application has not been 

configured.  When the Configuration status is green, this indicates the application has 

been configured and the CFDP service can be activated.   

 

Use the Configure button to access the Configuration dialog to configure the application. 
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Operational Status 

When the Operational status is black, this indicates the CFDP service is inactive.  When 

the Operational status is green, this indicates the CFDP service is active and file transfer 

is supported.  The application must be properly configured before the Activate button will 

be available.  The CFDP service must be active before the Deactivate button will be 

available. 

 

Use the Activate button to activate the CFDP service.  This will initiate all internal 

activities needed to prepare the application to send and receive files.  When you activate 

the CFDP service, you will see activation status messages in the main window message 

area.   If you need to reconfigure the CFDP application, deactivate the CFDP service, and 

then push the Configure button to reconfigure. 

 

5 TReK CFDP Tour 

Sometimes it’s easier to learn how to use an application by example.  This section 

describes how to use the CFDP application to transfer a file. 

 

This section was written assuming that you have read the Introduction section and the 

Main Window section.  If you have not read these sections, please go back and read 

them.  They contain important information that is not repeated in this section.   

 

If you have a firewall enabled on your computer, you may need to turn it off or allow 

traffic through for the ports and protocols used in this example. 

 

Please go through the tour in order.  Some sections depend on data from previous 

sections. 
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How to Transfer a File 
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5.1 How to Transfer a File 

The following steps describe the minimum necessary to transfer a file.  Typically CFDP 

involves transferring files from one computer to another computer.  An instance of the 

CFDP application is run on each computer.  The two CFDP applications communicate 

with each other using the CCSDS File Delivery Protocol (CFDP).  While normally you 

run an instance of the CFDP application on each computer, it is possible to run two 

instances on the same computer (doesn’t make a lot of sense but is possible).  In this 

configuration, you can transfer a file from one directory to another directory on the same 

computer.  To avoid the need for two computers, this is the approach taken in this 

tutorial.  The steps below describe how to use two instances of the CFDP application 

running on the same computer to transfer a file from one directory to another directory on 

the same computer. The configuration that will be used is shown in Figure 2.   

 

 

 

Figure 2 Tutorial Configuration 

 

While you will be doing this on a single computer, the steps to configure and run will be 

the same steps when you do this with two computers.    

 

 

Step-By-Step 

 

1. If you haven’t started the CFDP Application, use the operating system’s menu to start 

the application.  You should see the CFDP main window shown in Figure 3.  We will 

refer to this instance as CFDP Instance 1.   
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Figure 3 CFDP Main Window 

 

2. The Configuration Toolbar at the top of the main window contains a Configure 

button.  Push the Configure button to display the Configure dialog.  You should 

see the dialog shown in Figure 4. 
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Figure 4 CFDP Configuration Dialog 

 

 

3. The Local Entity ID is the Entity ID that will be used by this CFDP application 

when it performs a file transfer.  It defaults to 1.  This is the EID that should be 

used by CFDP Instance 1.     

 

Note:  If you have identified you will be using the CFDP capability in your 

Payload Integration Agreement, you will be assigned a “Ground Node ID”.  The 

Ground Node ID is an Entity ID and should be entered into the Local Entity ID 

field.  If there are multiple people on your team, your team may have more than 

one Ground Node ID.  Each team member who needs to run the CFDP application 

will need a unique Entity ID. 

 

4. The next step is to identify the remote entity that this CFDP application will 

communicate with.  This will be CFDP Instance 2 (which we have not started 
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yet).  Push the + button to create a row to enter the Remote Entity information.  

Type in the following information: 

 

Remote Entity ID:  2 

Remote IP Address: <Your Local IP Address> 

Remote Port:  4545 

 

Note:  The CFDP application can communicate with one or more remote entities. 

 

Your dialog should now look similar to the dialog shown in Figure 5. 

 

 

Figure 5 Configuration with Remote Entity 

  

 

5. Ensure the CFDP Socket Local IP Address and the Remote IP Address contains your 

local IP address.   
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6. All the other defaults in the dialog are acceptable. 

 

7. Push the OK button to save the configuration information and exit the dialog. 

 

8. If the application is configured correctly, the Configuration status in the main window 

will be green as shown in Figure 6.  If you do not see green, the most likely problem 

is the local IP address.  Verify that you have entered a valid local IP address for your 

computer. 

 

 

Figure 6 Configuration Status 

 

9. Go to the File menu and save the configuration naming it CFDP_Instance_1.  This 

will update the application title bar and make it easier to distinguish between the two 

instances once we have both instances running.  This is shown in Figure 7. 
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Figure 7 CFDP_Instance_1 

 

10. Push the Activate button located in the Configuration Toolbar in the main window.  

This will activate all the underlying services needed to perform CFDP functions.  If 

activation is successful, your main window should look like the one shown in Figure 

8.  The Operational Status will be green. 
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Figure 8 CFDP_Instance_1 Activated 

 

11. Now that one instance is configured and running, launch a second instance of the 

CFDP application. 

 

12. In the second instance of the CFDP application, push the Configure button and update 

the following: 

 

Local Entity ID:   2 

Remote Entity ID:   1 

Remote IP Address:  <Your Local IP Address> 

Remote Port:   4560 

CFDP Socket Local Port:  4545 
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Figure 9 Configuration for CFDP_Instance_2 

 

 

Note:  Now that you have configured both instances you can compare the configuration 

information.  You configured each instance with local entity information and remote 

entity information.   Both instances have information needed to communicate with the 

other.  As a reminder, the tutorial configuration is shown in Figure 10. 

 

 

Figure 10 Tutorial Configuration Reminder 
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13. Push the OK button to save the configuration information and exit the dialog. 

 

14. Verify the Configuration status is green. 

 

15. Go to the File menu and save the configuration as CFDP_Instance_2.   

 

16. Push the Activate button located in the Configuration Toolbar in the main window.  

This will activate all the underlying services needed to perform CFDP functions.  If 

activation is successful, the main window for CFDP Instance 2 should look like the 

one shown in Figure 11.  The Operational Status will be green. 

 

 

Figure 11 CFDP_Instance_2 

 

 

17. You are now ready to transfer a file.  The easiest way to identify the file(s) you want 

to transfer is to use drag and drop to drop the file(s) into the main window CFDP 

Commands list.  To get some extra help from the application, you can set some 

application defaults that will fill in information in the CFDP Commands list when 

you drop files into the list.  So before transferring a file, let’s set the defaults used by 

drag and drop.  Push the Configure button in the main window configuration toolbar.  

Go to the Options tab.  Set the Default Remote EID to 2 as shown in Figure 12. 

 



TREK-USER-0006 

 16 

 

Figure 12 CFDP Configuration Options Tab 

 

 

18. Push the + button to add a row to the Default Destination Paths list.   Enter the 

absolute path for your home directory (<C:\Users\<your username> on Windows or 

/home/<username> on Linux) on your computer.  Your dialog should be similar to 

the one shown in Figure 13.   
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Figure 13 Default Destination Path 

 

When you drag and drop a file the Remote EID will automatically be populated for you 

with the Default Remote EID.  The Default Destination Paths will appear on the Default 

Destinations menu in the application (more on this below).   

 

19. Push the OK button to save the configuration information and exit the dialog. 

 

20. In the main window under the CFDP Commands list, there is an option menu called 

Default Destinations.  Select the path you entered in the Default Destinations list in 

the Configuration dialog (<C:\Users\<your username> on Windows or 

/home/<username> on Linux).  Your CFDP_Instance_1 main window should look 

like the one shown in Figure 14. 
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Figure 14 Main Window with Default Destination Selected 

 

 

21. Let’s transfer a file.  Open a file explorer window and select a file to transfer.  Make 

sure it is not a file in your home directory since that is the destination of the file.  

Drag the file from the file explorer window and drop it into the CFDP_Instance_1 

CFDP Commands List.  If all the information about the file is valid, your main 

window should look similar to the one shown in Figure 15. 

 

Important Note:  If you see red text in the CFDP Commands List this is most likely 

due to selecting a file that contains one or more spaces in the path or filename.  

Spaces are not allowed.   You will need to change the location and or filename to 

remove the spaces before you can transfer the file.  If this occurs you can put your 

cursor in the row with the red text and push the Remove Row button to delete the 

row.  Then drag and drop the file (without any spaces). 
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Figure 15 CFDP Commands List 

 

Let’s take a look at what we have in the list.   

 
CFDP Command Syntax [CFDP Directive] [Class of Service] [source-path] [remote-EID] [destination-path] 

CFDP Command put class2 c:/cfdptest/file1.txt 2 C:/Users/kirk/file1.txt 

 
Command Field Value Description 

Put/Get put Indicates the file will be ‘put’ (copied) from the local entity 

(CFDP_Instance_1) to the remote entity (CFDP_Instance_2) 

Class of Service class2 Class 2 ensures reliable file delivery; any required 

retransmissions are requested and performed by CFDP. 

Source C:/cfdptest/file1.txt Identifies the ‘source’ file you wish to transfer to the 

destination (CFDP_Instance_2). 

Remote EID 2 Identifies the remote entity ID is 2. 

Destination C:/Users/kirk/file1.txt Identifies the ‘destination’ file by providing the absolute 

path and filename that should be used when the file is placed 

at the destination. 

 

 

22. Everything is ready to go.  Push the Execute All button in the CFDP_Instance_1 main 

window.   

 

23. You should see the Transactions area populated with transaction information in both 

the CFDP_Instance_1 main window and the CFDP_Instance_2 main window as 

shown below in Figure 16 and Figure 17.  Use the file explorer window to look at 

your home directory and you should see the file you transferred. 
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Figure 16 CFDP_Instance_1 Transaction Information 

 

Figure 17 CFDP_Instance_2 Transaction Information 

 

 

That’s it!  You have successfully transferred a file using CFDP.  For more information 

please see the TReK CFDP User Guide. 

  

Happy Transferring!!! 

 


